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1 About

NC-EAS(Y)©
Controlling the CNC milling machines in the Windows systems

Copyright © 1993 - 2006 by Michael Boenigk

Internet: www.easgmbh.de
E-Mail: service@easgmbh.de

It is FORBIDDEN to copy the software or any of the printed materials either in one piece or in parts
regardless of whether the software or materials are in their original or altered version.

All the data carriers have been checked and tested before dispatch for the presence of viruses or
errors. It is recommended, however, that the client additionally controls the data carriers. EAS GmbH
is not liable for any potential damage arising from the use of their programs / software.

It is FORBIDDEN to remove the LICENCE NUMBER from the software and to modify or disassemble
the programme. All the COPIES must comply with and be identical with the supplied original. As a
safety measure, it is ALLOWED to make ONE copy of the program.
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2 Basics

 The NC-EAS(Y) software is a program for controlling and operating CNC milling machines with three
stepper motors. Command signals are sent via a parallel port (LPT) or a USB port to the power drivers
and then to the built-in stepper motors of the CNC machine. The program also reads and indicates the
condition of the three limit reference-switches, the emergency STOP switch, the material height sensor
or the tool-length sensor. Two command signals, independent of the other signals, are used for the
switching on, with the aid of relays, of the mill spindle motor and the coolant pump.

The WINDOWS operating system does not allow, without the application of an extra external unit (a
special controller), for steering in real time. This is because in the Windows system the timer is used
for performing multi-task activities. Thus the stepper motors are driven with the aid of an external EAS
USB Controller controller which performs, among other tasks, the task of the timer, emits the
heartbeat signal and the direction signals for driving the 4 stepper motors.

2.1 What the NC-EAS(Y) program can do?

 The NC-EAS(Y) software has an innovative graphic interface. It is clearly devised and easy to operate.
All the main functions have been equipped with their respective icons and shortcut keys. The
CAD-similar interface of the software presents the working scope /area of the CNC machine, which
includes all the elements, e.g. drawing data, material, zero point, park point or the display of the
scan/measurement point.

The NC-EAS(Y) program is mostly used for performing the following work:
· milling
· drilling / boring 
· foil cutting
· engraving
· height scan/measurement
· drawing
· Processing into digital format

2.2 What you need additionally?

 The list below presents all the components (hardware and software) essential in order to use the
NC-EAS(Y) program:

· Operating system: Windows 98/2000/XP

· Microsoft .NET Framework V1.1 and Microsoft Internet Explorer 5.01

· Microsoft Managed DirectX9 or a later version for the joystick
· Pentium 400MHZ Processor or better (or equivalent hardware)
· Disc station CD-ROM
· RAM 64 MB
· Hard disc 40MB free
· USB Port
· Controller EAS USB Controller

The NC-EAS(Y) program is based on the latest Microsoft .NET technology and it requires the
Microsoft .NET Framework V1.1. Microsoft .NET Framework is free of charge and may be downloaded
from the Microsoft websites.
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2.3 Installation

The NC-EAS(Y) program may be downloaded from our website. On your request we may supply you
with the CD-ROM version of NC-EAS(Y). The CD-ROM also contains Microsoft Framework V1.1. To
install the NC-EAS(Y) program you need to perform the following operations:

1. Install Microsoft .NET Framework V1.1 by calling up the dotnetfx.exe file. The Microsoft
installation program will take you through the installation procedure in a step-by-step manner.
In the event that Microsoft .NET V1.1  was already installed earlier or if you are a user of
Windows XP with Service Pack 1, you may skip this stage of installation.

2. Install the NC-EAS(Y) program by starting the setupxxx.exe file. The  NC-EAS(Y)installation
program will take you through the installation procedure in a step- by-step manner.

3. To control the CNC milling machine with the use of the joystick it is essential to install
Microsoft Managed DirectX9 or its later version. To install Microsoft Managed DirectX9 call up
the installation file dxsetup.exe with the '/installmanageddx' parameter. 

Example: CD-ROM:DirectX\dxsetup /installmanageddx

To drive and control the stepper motors via the NC-EAS(Y) program, the EAS USB Controller
controller is essential. 

Very important: In order not tot interrupt the work of the CNC milling machine, Power Management
must be turned off in BIOS. Please also check the power management in the options of the Windows
management panel.

Installation of the EAS USB Controller drive
First install the NC-EAS(Y) program and then connect the USB cable (turn on the electronics). This is
in order to ensure that the USB drive has been copied onto the hard disc. Further information has been
included in the file install-en.pdf.

2.4 EAS USB Controller

The EAS USB Controller controller generates the heartbeat and direction signals for 4 stepper motors.
The maximum clock frequency equals 42kHz for the interpolation moves on 4 axes. Through the
inputs the reference connectors / pins may be read: start, stop, and other signals. Additional outputs
may be used for performing such operations as: turn on/off the pump, limit the motor current, turn
on/off the drill spindle motor and regulate its rotation. Organisation of signal flow on the controller
output connection has been adopted from the NC-EAS(Y) version for DOS system.

The controller is based on PLD (programmable logic device). The 12MHz quartz oscillator and the 64
kByte of data memory ensure a stable impulse transmission. Quick data exchange with the computer
is performed via the USB 1.1 port. Power supply for the system may be performed from the source of
port USB 1.1. or through  a flat cable connection of 5 V stabilised voltage to the MOST3/4A driver for
stepper motors.
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2.5 Starting up the NC-EAS(Y) program

Once the program is installed, NC-EAS(Y) may be started up by clicking the icon on the desktop or by
clicking the Start menu -> Programs key. NC-EAS(Y) may be started up only once. At the start up  it is
possible to quote a file along with a catalogue, which shall be opened automatically. 

Example: cnc.exe c:\directory\file.plt

During the first start-up, the NC-EAS(Y) program does not have any configuration setup and the basic
configuration is being established. Before you can do any actual work on the CNC machine, specific
machine parameters must be determined this only once, in the main menu "Settings - > Machine
parameters - > Adjust .." Optionally, it is possible to download the specific machine parameters from
the main menu "Setup - > Machine parameters - > Open..".  

All the machine parameters have been described in detail in the "Settings " chapter.  

Hint: Each time the NC-EAS(Y) program is started up a so-called "reference move " must be
performed. This operation makes it possible to determine the ZERO point, which means that from this
moment on the program is able to recognise where the point of coordinates 0,0,0 is. Without this
operation the program will not recognise  the position of each of the machine axes. 

18
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3 Menu

 In order to make the implementation and usage easier, the NC-EAS(Y) program has been equipped
with an innovative, graphically designed interface, which is much similar to the standard WINDOWSÓ
applications.

3.1 Horizontal and vertical toolbars

 The most crucial functions are equipped with their relative icons on the horizontal and vertical toolbars,
and shortcut keys.

Illustration 1: The vertical toolbar has all the drawing functions. 

The vertical toolbar has the following drawing functions (from top to bottom): 
· Change of tool number and the direction of milling
· Locate on work-piece/material or the machine area 
· Copying the vectors, drill points or their parts 
· Rotating the vectors or drill points 
· Mirror reflection according to X-axis Y-axis
· Expanding the drawing on the work-piece/material or the machine area

Illustration 2: The horizontal toolbar is divided into sectors.

The horizontal toolbar is divided into the following sectors (from left to right): 
· The data sector includes the following functions: Open new file, Open file, Save file, Undo,

Repeat, Selection Window (choice between vectors, drill points or all) 
· The view sector includes the following functions: Display machine area, Display

work-piece/material, Display drawing, Expand with the window, Expand or diminish the drawing 
· The setup sector includes the following functions: Unit, Toolbox, Machine parameters, Material

parameters, Positions, and Quick setting of point zero. 
· The moves sector includes functions which govern the movements of the CNC milling machine.

These functions are: Mill/Drill, Stop the CNC milling machine, Pause in the work of the CNC milling
machine, Scan area of material height, Reference move, and Manual advance.

Hint: The toolbars may be turned on or off in the main menu. "View -> Toolbars".



NC-EAS(Y) help6

Copyright © 1993 - 2006 by Michael Boenigk

3.2 Main menu "Pulldown" bar

 The "Pulldown" main menu bar includes all the functions except "Selection Window" and "Unit". The
"Pulldown" main menu bar consists of the following options:  

Illustration: "Pulldown" main menu

1. The File menu includes functions which concern file processing / editing. Some functions at your
disposal here are: "open file", "close the opened file", "open text editor". Detailed information on the
topic of files has been included in the "data" chapter. 

2. The Edit menu includes functions which concern the processing of entered data.  A drawing may be
altered here or the Tangential cutter correction may be calculated. Detailed information on the topic of
data processing has been included in chapter entitled "Data editing"  

3. The View menu includes functions which change the size of the loaded drawing.  Detailed
information on the topic of viewing data has been included in the chapter entitled "The Zoom function"  

4. The Move menu includes functions which advance the CNC milling machine. Some of the functions
are: "Simulation", "Job", "Material height scan" or "Machine manual advance".  Detailed information on
the topic of advancing the CNC machine has been included in chapter entitled "Move" 

5. The Setup menu includes all the functions concerning the setup of the CNC milling machine and
the NC-EAS(Y) program. The particularly important function is "Machine parameters" which must be
set well so that the CNC machine operates accordingly. Detailed information has been included in the
"Settings" chapter. 

6. The Help menu is equipped with a user's manual and information on the topic of NC-EAS(Y). 
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3.3 The status bars

The NC-EAS(Y) program is equipped with three status bars which provide the user with the following
information:
 
· Both upper status bars indicate the current position of the CNC milling machine. The position is

displayed in absolute and relative coordinates in millimetres. Relative coordinates may be deleted in
the "View" dialogue window or directly on the status bar by pressing the key of a particular relative
coordinate.

Illustration 1: The upper status bars with relative and absolute coordinates of the CNC machine.

· The bottom status bar indicates the mouse coordinates, the unit, and provides information related to
the CNC milling machine's work (amount of work performed in %, tool number, speed of manual
drive,…)

Illustration 2: The bottom status bar

Hint: The status bars may be turned on or off in the main menue "View -> Toolbars".
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3.4 The coordinate system

 The machine coordinate system corresponds to the Cartesian coordinate system. The starting point of
the X and Y axes is located in the left bottom corner. Once a Reference Move is performed, the
counters for the machine absolute coordinates for axes X and Y are set to value 0 (zero), whereas for
axis Z the before set length of axis Z. 

Note: When the Z-axis is moved downward, the value of the Z axis counter diminishes!  

Illustration: The coordinate system

The mouse coordinate system
The left bottom corner of the screen displays the mouse coordinates. These co-ordinates may either
be displayed in centimetres or in inches. Additionally, it is possible to switch to and from the absolute
and relative values. The relative values have their origin in the zero point of the material, whereas the
absolute values in the zero point of the machine. The icon for switching between the absolute-relative
values and the centimetre-inch values is located on the horizontal tool bar. 

Description Key Menu command Icon
Switching between the absolute and
relative values and cm/inches

none none
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3.5 Interface

 The USB port in a PC computer includes input and output drives. The input is used for reading the
signals sent by the machine e.g. by the limit switches. The computer, on the other hand, sends,
through the output drives, signals which control the machine. Clicking the mouse left key on a proper
area changes its active level to the opposite level. Clicking the mouse on input 1 switches on or off the
cutter / fraise drive. 

Description Key Menu command Icon
Dialogue window " Interface"
enables control over the USB
port  input and output drives

[Ctrl + I] View · Interface none
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4 Data files

The NC-EAS(Y) program makes it possible to import various data file-formats: HPGL, DIN 66025,
Excellon, Sieb & Maier 1000 and Sieb & Maier 3000. The read data files can be altered in size by
scaling or changing the scale.

4.1 Working on the data

The "Open / Insert" dialogue window makes it possible to enter new or insert / load other data to the
files currently open. Both windows are the standard dialogue windows for the Windows system. 

Open file

In order to open a data file, click on icon  on the horizontal toolbar. Alternatively, a date file may be
opened in the main menu of the NC-EAS(Y) program or by pressing a shortcut key.

Description Key Menu command Icon
Open file [Ctrl +O] File · Open
Choosing 1 of the 4
recently retrieved files

none File · 1 to 4 none

In the "Open" dialogue window the following types of files may be chosen:
· HPGL(*.plt)
· DIN 66035(*.nc)
· Sieb & Maier(*.drl), Excellon, SM1000, SM3000
· NC-EAS(Y)(*.grf)
· all NC files(*.*)

When choosing a type of file without a file extension (*.*), this type of file shall be recognised
automatically. 

Hint: In the event that the type of file could not be recognised automatically, the following information
appears:

"File ,c:\example.nc' is of unknown format. Do you wish to quote the file type and try again?"

For the file to be loaded anyway, the file type must be entered in the successive attempt to load the
file.

Insert file
Once a data file is opened, it is possible to insert into it a drawing from an outside file. The procedure
is identical here as in the case of opening a file.

Description Key Menu command Icon
Insert data none File · Insert none

In the "Insert" dialogue window the following types of files may be chosen: 
· HPGL(*.plt)
· Sieb & Maier(*.drl), Excellon, SM1000, SM3000

Once the unit and the scale of the drawing are selected, the "Location choice" dialogue window
appears which makes it possible it define the location of the inserted file. 
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Browse with the aid of the view window
With the use of the "Browse" function it is possible to view the files in the view window before they are
loaded. A file is loaded with a double click of the left mouse button. All the loaded files are
automatically added to the "Favourite" list which then makes it easy to find a particular file and load it
again.

Description Key Menu command Icon
Search with the use of the view
window 

none File · Search

Hint: In the course of opening the files the settings defined in the "File formats " dialogue window
are applied.

4.2 Interpreter HPGL

Hewlett Packard Graphics Language, HPGL in short, is a data format generated or exported by almost
all CAD-programs. The NC-EAS(Y) program interprets the following HPGL commands: 

HPGL functions
PU - Tool up
PD - Tool down
PA - Further move to positions with latest definitions 
PR - Move to relative position
SPx - Tool number
AA - Absolute arc
AR - Relative arc
CI - Circle

Example
HPGL Description of commands

 

PU;
PA100, 50;

PR100, 50;

PD;

CI100;

AA300, 200, 50;

SP1;

 

Tool up
Move to the absolute position, X=100, Y=50

Move to relative position, so that the new absolute
position is: X200,Y100
Tool down

Circle radius equal 100 counter-clockwise, (for radius
-100 clockwise),

Draws a 50-degree-radius arc with its centre at point
X300,Y200 and the starting point at 100,50

Tool choice (here tool no.1)

29
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4.3 Drill data interpreter

 The NC-EAS(Y) program recognizes the following drill data formats: Excellon, Sieb&Maier 1000 and
Sieb&Maier 3000. Two examples have been provided below:

Sieb & Maier Description of commands
Example 1 Example 2

%
T01

X001Y0001

M30

 %
T01

X100Y10

M30

T01 Tool no. 1 has been selected

Move to positions X100, Y10 and
the tool immerses in the material

M30  end of program

There are two types of drill data at your disposal. The first format (see example 1): the coordinates are
always 5-digit ones. This is why they have the leading zeroes. The back zeroes are frequently skipped.
The second format (see example 2) has no leading zeroes and the numbers are of varied length. The "
File formats " dialogue window makes it possible to set the type of drill data.29
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4.4 Interpreter DIN 66025

 The standardized data file-format DIN 66025 is the standard applied in professional CNC 2½ and 3D
machines.

Hint: The Din 66025 type files may not be edited. Only copying, moving and scaling is possible. 

The NC-EAS(Y) program interprets the following commands:

G-Codes:
G00 Rapid advance 
G01 Working speed advance 
G02 Circle (Arc) clockwise movement 
G03 Circle (Arc) counter-clockwise movement
G04 Pause
G70 Unit in inches
G71 Unit in millimetres
G90 Absolute mode 
G91 Relative mode 
 
M-Codes:
M03 Turn on the power feed of the tool
M05 Turn off the power feed 
M08 Turn on the coolant pump 
M09 Turn off the coolant pump 
M30 End of program 
 
Other CNC commands
F Advance rate  mm/min  
N Task number
T Tool number
 
The G00 command moves the tool with the maximum speed rate of the milling machine. The tool is
positioned above the material.

Example 1
DIN 66025 Description of commands
NO1 G00 X0 Y0 Z10
N02 M3 M8

N03 G01 Z-2 F50

N04 G01 X100 Y100 F100

N05 G00 Z10 M5 M9

N06 M30

Moves the tool to point X0, Y0, and
Z10 
M3 turns on the drill spindle  M8 turns
on the coolant pump 

The tool penetrates the material 2mm
deep with the speed of 50 mm/min.

Moves the tool at advance seed rate of
100 mm/min. to point X100 and Y100

Moves the tool to position Z10 M5
turns off the drill spindle M9 turns off
the coolant pump 

End of program.

The G02 command moves the tool along the arc in a clockwise manner, whereas G03 moves the tool
counter-clockwise. The starting point of the arc is in the current tool position. The end of the arc is
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determined in commands G2(G3) with the use of commands X,Y and Z, which stand for, respectively,
the coordinates for axes X, Y and Z. Commands  J and I determine the centre of the circle. 
Please find below the control commands for the G2(3) instructions:
 
X End coordinates in axis X
Y End coordinates in axis Y
I Circle centre in axis X
J Circle centre in axis Y
K Circle centre in axis Z

Example 2
DIN 66025 Description of commands
N01 G00 X0 Y0 Z10
N02 M3

N03 G01 X10 Y10 F100

N04 G01 Z-2 F50

N05 G02 I20 J10 X30 Y10

N07 G00 Z10 
N08 M30

Moves the tool to position X0, Y0 and 
Z10 
M3 turns on the drill spindle

Moves the tool at the speed rate of 100
mm/min. to position X10, Y10

The tool penetrates the material 2mm
deep with the speed of 50 mm/min.

Moves the tool along the arc with the arc
centre at point I20, J10, from point X10,
Y10 to X30, Y10

Lifts up the tool by 10 mm
M30 End of program

Example 3 illustrates the making of a screw thread (2mm pitch of thread 6 mm long) – 3
coils/convolutions. When making a full circle, the starting point corresponds to the ending point.

Example 3
N01 G0 X500 Y500
N02 G0 Z-5
N03 G2 I550 J500 Z-7 F60
N04 G2 I550 J500 Z-9
N05 G2 I550 J500 Z-11
N06 G0 Z0

The G04 command enables a delay to be programmed. G04 H2 denotes a 2-second delay. This
function is used, for example, to allow time for the drill spindle to gather speed. 

Example 4
DIN 66025 Description of commands
N10 G04 H2.5 The tool stops for 2.5 seconds (the drill

spindle continues rotating)

The G90 command sets the coordinate system at the absolute values.

Example 5
DIN 66025 Description of commands
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N08 G90
N09 G01 X100 Y100
N10 G91
N11 G01 X10
N12 G01 X5 Y-5

Absolute coordinates
Moves the tool to position X100, Y100
G91 switches on the relative
coordinates
Moves the tool to position X110, Y100
Moves the tool to position X115, Y95

The list of control commands may be created under any freely chosen text editor. Small letters may be
used but the command code must not contain any blank spaces. It is not obligatory to number the
instructions and so numbering may be skipped.
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4.5 Interpreter GRF

 The GRF format is the format of the NC-EAS(Y) program and it saves in the file all the changes made
by the NC-EAS(Y). The GRF format includes the following information: 

· Vectors and drill points 
· Tools for vectors and drill points 
· Unit and drawing scaling (for file DIN 66025 only scaling) 
· Material offset and the zero point of the material 

When opening the GRF file, NC-EAS(Y) checks whether the zero point in the GRF format is used. If
the zero point is not used, the user is presented with a request to check the offset of the material.  
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4.6 The zoom functions

The size of the drawing can be increased or reduced at any time. In order to achieve this aim you can
choose from several options. For instance: you can use the mouse to click on the Zoom icon or press
the key 1or 0. The "Zoom window" function makes it possible to enlarge / expand the fragment
indicated with the mouse (a rectangle section). The "Pan" function moves the drawing without
changing its size.

All the zoom-functions have been listed in the table below.

Description Key Menu command Icon
Zoom a selected area none View · Zoom window
Enlarging the drawing none none

Diminishing the drawing none none

Display the drawing [F4] View · Display drawing
Display the machine area [F3] View · Display

machine area
Display the material [F2] View · Display material
Zoom in / out [ 1 or 2 ] + mouse

position,  or mouse with
scroll

none none

New drawing [Ctrl + R] View · Refresh none

Move the drawing (Pan) Mouse position + mouse
right key + Pan

none none

Vertical and horizontal
drawing-move bar (Pan)

Mouse left key on the
drawing move-bar

none none
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5 Settings

 In order for the NC-EAS(Y) program to control the stepper motors, the CNC milling machine
parameters and the NC-EAS(Y) program parameters must be set and adjusted accordingly.

5.1 Machine parameters

Once the program is installed, it is required to determine what the parameters of the CNC machine
are; the CNC machine is referred to here as the "machine". The parameters must be determined
correctly as their wrong introduction may hamper the operation of the machine and may even lead to
the damage of the processed material, the milling cutter / the drill or the milling machine. 

To enable a quick change in the parameters for various types of machines, the machine parameters
may be entered into a file or a machine parameter file may be opened. 

Description Key Menu command Icon
Opening a dialogue window with machine
parameters

[F8] Settings · Machine
parameters · Adjust

Opening a file with machine parameters none Settings · Machine
parameters · Open

Saving machine parameters in a file none Settings · Machine
parameters · Save

All the CNC milling machine parameters are saved in the NC-EAS(Y) in the "machine" directory in an
XML file type. The dialogue window "Machine parameters" is organised in the following manner: 

Code
Axes

Axis of rotation
Tangent axis
Backlash elimination

Pin parameters (Port A)
Input signals (Port A-B )

Speed
Automatic tool change
Height scan sensor

The "OK" and "Apply" keys
Any changes made in the "Machine parameters" dialogue window are saved by pressing the "OK" or
the "Apply" keys. The "Apply" key does not close the dialogue window and the introduced changes are
applied right away without opening and closing the dialogue window.

19
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5.1.1 Code

When the machine parameters are set, it is sometimes worthwhile to protect them from inexperienced
users. The introduction of a code makes it impossible for unauthorized users to gain access to the
"Machine parameters" dialogue window. Similarly, it is then impossible for others to save CNC
machine parameters. To turn off the code it is necessary to enter the current code into the "old code"
option leaving other options blank.

Hint: As help in case the code is forgotten, it is possible to enter a tip (word or sentence) concerning
the code.

5.1.2 Axes

NC-EAS(Y) may control up to 4 axes. Additionally, it is possible to control axis X with a double drive.
The following settings are at available:

· The length of axis Z is assumed to equal its permissible scope of revolution. On the screen, the
scope of revolution of axis X and Y is shown as a white sheet.  

· To define the axis resolution, for each axis the number of steps per rotation and the rotation path
must be quoted. Initially, the axis resolution is calculated automatically in millimetres per step and is
presented in a box below. 

· Connector A switches on or off the fourth axis. When the fourth axis is switched off, it is not
possible to use the axis of rotation or the tangent axis  as axis four. Axis A is available in the
controller versions from V2.0 to EAS USB Controller.

· Axis of rotation  may work with a 4-axes driver as well as, with certain inconveniences, with a
3-axes driver.

5.1.2.1 Axis of rotation

Depending on the number of axes of the steering electronics, two work modes are possible:

4-axes driver

The machine parameters allow the axis of rotation to be defined as the fourth axis once the axis 
switch has been activated. The axis of rotation may be installed on the milling table in the direction of

axis  or axis . Selecting an adequate direction:  direction or  direction results in directing the
coordinates of a selected axis to the axis of rotation.
If the scratch file has coordinates for all 4 axes (processing in four dimensions), then the  selection of
direction X or Y serves merely the purpose of displaying the axis position on the screen. The reference
move to the limit switches and positioning may take place on 4 axes.
 
3-axes driver

With a 3-axes driver, axis A must be inactive (the  switch  is turned off).
The axis of rotation is connected to the driver (output X or Y) through a change / swap of plugs.

Symbolic presentation of the axis of rotation on the screen
Once the axis of rotation is switched on in the menu "Machine parameters-> Axes -> Axis of rotation", 
the length line shall appear on the screen U=DxP, where D is the diameter of the material.  Another
line runs from the onset of the length line and perpendicularly to it, a line which corresponds to the axis
of rotation. The third dashed line outlines the material area.

Positioning the axis of rotation
Once a device with the axis of rotation is installed on the milling table, its position must be entered into
the program.

1. Before switching on the axis of rotation in menu "Machine parameters -> Axes -> Axis of rotation",
perform a reference move.

2. Fix the material to the rotation axis handle.

20
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3. Using the manual advance locate the device blade on the onset of material and over its axis of
rotation.

4. Save the position in menu "Location" under the name "Axis of rotation".
5. Switch on the rotation axis in menu "Machine parameters -> Axes -> Axis of rotation". Lines will

appear on the screen symbolizing the axis of rotation with a direction adjusted to a selected axis (X
or Y).

6. When using a 3-axes driver it is now possible to plug in the axis of rotation in place of a selected
axis (X or Y).

5.1.2.2 Tangent axis

For cutting thick foil or cardboard a Tangential cutter is used. The Tangential cutter is set, with the use
of stepper motors, in the direction of material cutting. The applied cutter must be double-edged with
the blade in the axis of rotation. For the drive of a stepper motor a 4-axes driver is necessary. Once

the 4 axis is activated with a switch , the function of the tangential cutter is available. 

Steps/turn is the number of stepper motor steps per one full turn. Raise from the angle is the angle
in degrees between the subsequent segments (vectors) within the scope of which the cutter remains in
the material in the course of its rotation, in agreement with the direction of move. Over this angle the
cutter is removed from the material, turned in the new segment cutting direction and is again
immersed into the material. To avoid damage to the material, the value of this angle should not exceed
45 degrees.

5.1.2.3 Backlash

Backlash is undesirable play between the spindle and the cap or between the pinion and the toothed
bar of the power drive. The play is generated in the course of a change in move direction. This function
cancels the play. Backlash is entered for axis x, y and axis z in millimetres or in steps.

Hint: The "Backlash elimination" function is applied only in the course of milling / drilling.
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5.1.3 PIN parameters (Port A)

It is essential to correlate the move directions, input and output, and so they must be adjusted. The
following settings are available:

· Reference connectors may be inverted manually or with the aid of the PIN reference assistant.

Illustration: PIN reference assistant

· In the course of the Reference Move, first the Z axis moves upwards until the limit switch switches
into operation, and next the axes X, Y and A perform the same operation in a set reference move
sequence. Once all the axes reach the limit switches,  they then move slowly in the opposite
direction until the switches are disconnected. The counters for axes X, Y and A reach the zero value,
whereas axis Z is set at the length of this axis.

· The move direction and reference move direction may, if needed, be changed. The correctness
of a set direction may be checked in case of manual advance. Axis X moves forward when pressing
the cursor-key ®. The ­  key moves the Y axis forward, whereas the ¯ key moves the Z axis
downwards (that is in the negative direction). 

· It is advisable to limit the motor current as it protects the driving motors against overheating in the
course of a lengthy inactivity.

· Controller EAS USB Controller has input drives 1,2,3 and 6 for the reference move. Depending on
the cables, connectors X, Y, A and Z may be freely assigned to the reference input drives.  

· The hood connector controls the hood in the course of milling. If the hood is raised in the course of
milling, then milling is stopped and the "Raised hood" report appears.

· Sometimes the output drives are distorted and they function the other way round. In this case such
output drives must be inverted. The spindle, pump, motor current and the fixing clamps may be
inverted. Output may also be adjusted for the pump, spindle and the fixing clamps.
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5.1.3.1 Input signals (Port A-B)

There are further 9 inputs on the side of the EAS USB Controller controller. These are for the following
external signals:
· Start the machine

· Pause, the machine has been stopped
· Start the reference move
· The hood has been opened. If the hood has been opened in the course of milling or the reference

move, then the work of CNC milling machine is stopped immediately and the message "Hood is
open" appears.

Hint: The external signal must be ticked in order to be activated.

5.1.4 Speed

The speed must be adjusted accordingly to the type of the CNC milling machine. Too high speed may
result in a loss of step. The following parameters are available:

· The maximum speed parameter determining the maximum permissible speed, at which the
machine operates appropriately and skips no steps.

· Reference speed is the speed of axes X, Y and Z in the course of performing the Reference Move. 
· The Start/Stop speed prevents step skipping in the course of accelerating or stopping the motors.

The value of this parameter must not be too high. 
· The constant working speed is also constant in the course of interpolation moves. 
· Acceleration rate may be low, average, high or extremely high. 
· Move speed to a scan / measurement point is the speed of axis Z in the course of a move to the

height scan point. Once the height scan is performed, axis Z is raised at the Start/Stop speed.

5.1.5 Automatic tool change

The automatic tool change option has control over the machine / device and may have up to 33 tools.
To use the automatic tool change option the following operations must be performed:

· The Properties define the general setup for the automatic tool change. The first thing to do is to
switch on this option by pressing the connector.  Waiting time is the time when the opened spindle
is waiting and subsequently either picks a new tool or puts away the old tool. Once the tool position
is arrived at, an immersion is made on axis Z with the entered speed and segment. Connector
allows to count the tools from number 0. Finally, the colour of the empty of full space in the device
may be given. 

· Next the position X, Y and Z of the first tool must be given.
· The Offset list defines positions of the next tools (maximum up to 32). The offset is the distance of

axis X and Y to the last tool. Particular tools may be switched off by clicking a box on the list. Tools
switched off are not displayed graphically.
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5.1.6 Height sensor

The height sensor measures the height of the material surface. With the backup of data, the measured
material surface, NC-EAS(Y)  corrects the height of the drill spindle (axis Z) in the course of milling. A
further possibility is the export of material height data to DXF format (as lines or points) or to format
Din66025. For the height sensor  to work appropriately, the distance (offset) in X and Y between the
height sensor and the tool tip (see: illustration) must be measured carefully and accurately. 

Illustration: Distance between the height sensor and the tool

How to calculate the distance between the height sensor and the tool (Offset):
1. Move the machine to Point Zero of the material and carefully and accurately mark this position on

the material e.g. by scratching the surface with the tip of the milling cutter. 
2. Change the machine coordinates to Relative and make a note of them. 
3. Locate the tip of the height sensor precisely above the marked point. 
4. Choose the "Machine parameters" option from the menu and enter the previously noted

coordinates into the Offset area/box
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5.2 Positions

In order to perform a move to the park point or the measurement point, the points must first be defined
in the "Position" dialogue window. This window may be opened through the main menu of the program
or the "Manual advance" dialogue window.

Description Key Menu command Icon
Position setting [Ctrl +P] Settings · Position (in the program main menu)

or Settings · Zero point/Park point/Measurement
Point (in the "Manual advance" dialogue menu)

Here any number of zero points, park points and measurement points may be defined, however only
one of each of the point types may have the "in use" status. For this reason only (maximally) one zero

point , one park point , and  one measurement point is graphically displayed in the
drawing.

Selection of zero point, park point and measurement point 
By choosing a relevant tab the type of position for the purpose of processing is selected and a list of
such positions appears.

Illustration: Tag selected for zero points

Insert positions
By clicking the "Add" option, the "Add positions" dialogue window appears. Here the parameters of a
new point (X-, Y-, Z-, A- coordinates, status and name of point) are entered. By clicking "Insert" the
current machine coordinates are entered into the input fields. Height may be defined by entering the
material thickness data. In order to enter the material thickness data, calibration of the tool-length
sensor must be performed once.

Change positions
First you need to select a point, that you wish to change, from the list. Then it is possible to change the
properties of the selected point directly by clicking on the column in the table of a particular point value.
Also by selecting "Insert positions"  you may enter the current coordinates of the CNC milling machine
by clicking "Insert".

Delete positions
In order to delete a location from the list, first the selected location must be entered and then the 
"Delete" key must be pressed.

Changing the properties of positions
These properties define the performance of zero points, scan points and park points. A move to a
particular point may be performed directly or in a defined sequence of axes. The "Display
confirmation" option turns on or off the dialogue window which appears prior to a move to a point. A
move to the zero point may be performed automatically after the reference move.
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5.3 Material offset

The material offset is the distance between the point at which the tool is fixed and the material zero
point (see: Illustration 4). In the GRF format of the NC-EAS(Y) program the material offset and the
material zero point are recorded. Material zero point is recorded in the GRF format only for control
purposes while opening this file. In the event that the material zero point of the entered drawing does
not correspond to the currently active material point, the following information is displayed: 

„NC-EAS(Y) has no zero point for the particular the drawing! Please check the material offset."

Illustration: Material offset.

Hint: If the zero point of the material has changed, there is no need to change all the GRF type files
but just the material offset in the opened GRF file. 

The menu of the "Manual advance" dialogue window makes it possible to define the material offset
manually by entering the data with the use of the keyboard or by moving the machine to a given point.

Description Key Menu command Icon
Material offset in X and Y is
entered from the current machine
position 

none Edit (in the "Manual advance"
dialogue window) · Insert
offset · XY

none

Material offset in X, Y and Z is
entered from the current machine
position

none Edit (in the "Manual advance"
dialogue window) · Insert
offset · XYZ

none

Material offset in X is entered from
the current machine position 

none Edit (in the "Manual advance"
dialogue window) · Insert
offset · X

none

Material offset in Y is entered from
the current machine position 

none Edit (in the "Manual advance"
dialogue window) · Insert
offset · Y

none
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Material offset in Z is entered from
the current machine position 

none Edit (in the "Manual advance"
dialogue window) · Insert
offset · Z

none

Manual entry of material offset
data

none Edit (in the "Manual advance"
dialogue window) · Insert
offset · Manual data entry 

none

5.4 Material parameters

 For the purpose of visual control, the size of the processed material may be graphically displayed on
the screen.

Description Key Menu command Icon
Opens the "Material parameters" dialogue
window

none Settings · Material parameters

In direction X and Y the defined material size (in millimetres) may be displayed in a freely chosen
colour. From the list of existing zero points a new zero point may be selected. 

Hint: If a new point is needed, it must be defined in the "Position " dialogue window. 

5.5 Toolbox

The "Toolbox" dialogue window controls the two lists of tools for the vectors (for HPGL and optionally
for DIN 66025 – see chapter: "File formats ") and the drill points (Sieb & Maier). Each list may
manage up to 100 tools and offers such properties as, for example, working speed, speed of pulling
out the tool, depth of penetration, diameter, etc. These properties are used in the process of milling,
drilling or at calculating the tool correction. The column "Active/No." enables the switching on and off of
particular tools. Switched off tools are not displayed in the drawing and are not used for milling and
drilling. 

Description Key Menu command Icon
Opens the "Toolbox" dialogue window [Ctrl + T] Settings · Toolbox

Depending on the depth of immersion and the type of tool, the diameter of the milled surface changes.
As help for the calculation of the diameter the "Calculate diameter" dialogue window may be used by

clicking the key  beside the diameter box. Calculation of the tool diameter is possible only for the
milling cutter. The diameter is necessary for tool diameter correction .

Hint: The "Display tools in use" function limits the tool overview to the tools currently in use. 

5.6 Macros

 In the "Macros" dialogue window it is possible to define operation sequences, operations that may be
part of the milling or drilling process and that could be called up at any given point. This way the
performance of various tasks may be automated. Each operation sequence, here called a macro, is
saved under a file name. The "Macros" dialogue window displays a list of all the program macros.  

Description Key Menu command Icon
Macro – process none Settings · Macros none

Saving and changing a macro
Upon clicking the "New" option in the "Macros" dialogue window, the "Macro save" dialogue window
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appears where a new macro is defined. If an existing macro is to be changed, then it must be selected
from the list displayed in the "Macros" dialogue window and the option "Edit" must be selected.

The "Macro save" dialogue window consists of two sections:

1.The "Macro" section includes a list with the commands of a given macro. The macro is performed
according to this list, from top to bottom. The list consists of a sequence and all the parts of the
sequence are performed. The sequence may be changed by pressing the arrow function keys. Single
sequences are cancelled by pressing the "Delete" key. A new sequence may be set up or changed in
the "Command" section. 

2.The "Command" section allows for the addition of a new task to a particular macro or for changes to
the tasks existing already. The following commands are available:
· With the use of the absolute vector a move to a chosen X, Y, Z and A point is performed. The

speed of the move is entered manually or by quoting the maximum speed of the machine.
· Waiting time stops the machine for a given time in milliseconds.
· With the use of a connector the drill spindle and the pump are turned on or off.

Saving a macro
Once a macro is established it must be saved in a file. All macros are saved in the "Macros" catalogue
in files supplied with the .macro extension. To save a macro the "Save" option must be clicked in the
"Macro save" dialogue window.

Exporting macros
Macros may be exported for further editing in format Din 66025. To export a macro you need to select
a particular macro from the list and click the "export" key. 

Testing a macro and applying it to / inserting into Milling/Drilling
Before a macro is applied in the "Milling/Drilling" operation it should be checked first. The "Perform
macro" dialogue window enables the application of particular macros through the selection of a
particular macro from the list and clicking the "Start" option.

Description Key Menu command Icon
Single macro
performance

none Move · Macro none

Editing,
apply/insert macro

[F9] Move · Milling/drilling

Any macros for the operation of "Milling/drilling" may be entered into the "Work parameters" dialogue
window. The first thing to do is to activate a macro in the "Macro" section. Then a particular macro
must be selected from the list of macros and the place for its application  must be defined. Here
various possibilities apply:

· Perform macro at the beginning of work
· Perform macro at the end of work
· Perform macro after processing (the "Repeat processing" function)
· Perform macro after tool change

Upon selecting a macro and defining the location for the performance of a given macro, the particular
macro must be added to the performance list with the '->'  key. With the use of the '<-'  key the macro
is removed from the performance list.
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5.7 Options

 The "Options" dialogue window includes all the settings of the graphical editor of the NC-EAS(Y)
program. These settings have been grouped into "General", "View", "Performance" and "Editor" tabs. 

Description Key Menu command Icon
General settings of the
graphic editor 

none Settings · Options none

General
The Scratch catalogue is the starting point once the "Options" and "Save" dialogue window is
opened. This means that once these windows are opened a defined scratch catalogue shall appear. 
Once the file is opened, the drawing may be positioned automatically at the zero point or at the
original position acquired from the file. 

The position of the drawing or the material, lack of command M03 (only Din 66025) or lack of a
reference move may be checked before milling. For NC-EAS(Y) to be able to control, the command
given must be active. Changing the zero point makes it possible to move the drawing together with the
material. 

View 
This option includes the settings which define the view of the idle running of vectors, the area of height
scan, the raster, tool correction and the absolute and relative coordinates. The size of the raster is
arbitrary and is quoted in millimetres or in inches. The view of the particular elements may be switched
on or off in the main menu "View". Font types may be defined for absolute and relative coordinates. In
the main "View" menu it is possible to turn on or off the status bars . 

Performance
The NC-EAS(Y) program stores the drawing data in its memory. With a big file, the system may be
overloaded. To solve or eliminate this problem the NC-EAS(Y) program has been equipped with a few
functions which limit the overloading of the system.
   
· The processing of big files, for instance the Din 66025 type of files, is purposeful only conditionally.

This is why it is possible to quote the size in Mbytes for files where processing is to take place. If the

quoted size is exceeded, then the symbol shall appear on the bottom status bar. The NC-EAS(Y)
program loads files also saving on the computer memory and only the shifting and scaling of the
drawing data is possible.

· A graphic display of the processing requires a big memory and system capacity / performance. This

is why it is possible to switch this option off. If, on the bottom toolbar, the symbol  (see above) is
displayed, this indicates that this function is automatically switched off.

· With big files it may take a while for a drawing to be displayed on the screen. To speed up the
display, it is recommended to switch on the OpenGL function. OpenGL enables direct access to the
graphic card hardware and speeds up the process of drawing. Upon switching on the OpenGL
function, it is recommended to visually monitor the drawing process.

· Format GRF files of the NC-EAS(Y) program may be automatically comprised in the zip format. This
considerably reduces the size  of GRF files, however the loading or saving requires more time.

Editor
It is here that a text editor which reads HPGL, DIN 66025 i Sieb & Maier files is applied / inserted. In
the event that one of the said files has been opened by the NC-EAS(Y) program, the file may be edited
with the text editor through the main menu "File -> Open with editor". GRF files may not be processed
with an external text editor. 

7



Settings 29

Copyright © 1993 - 2006 by Michael Boenigk

5.8 Keypad

 The dialogue window "Keypad" may define, for some functions, shortcut keys of the keypad. As such
functions are activated directly with the keys, it is recommended that the keys be selected carefully.
The whole list of defined keys may be switched on or off with one connector. 

Description Key Menu command Icon
Definition of shortcut keys
for some functions  

none Settings · Keypad none

5.9 Joystick

NC-EAS(Y) may control the CNC milling machine with the application of a joystick. Joystick steering

may be tuned  on or off with the use of the connector. One of the joystick keys may be defined
for changing the speed of the manual advance.

Important: To facilitate joystick steering, Microsoft Managed DirectX9 (see: installation ) must be
installed.

5.10 Unit and scaling

 Without determining the appropriate units of measure, the entered drawing shall not be correct. To
make the selection of an appropriate unit of measure easier, some of them have been defined (1 mil,
1/40, 1/100, 1/1000 mm). In the event that there is no pre-defined unit of measure, it is possible to
enter one's own definition with the use of the keypad keys. Additionally, the entered drawing may be
recalibrated    by quoting an appropriate scale for X, Y or Z. 

Description Key Menu command Icon
Changing the units of measurement and
calibration of the entered drawing

none Settings · Unit and scaling none

Hint: The measurement unit for file type DIN 66025 may not be changed, this is why the "Scaling"
dialogue window appears with no possibility, however, of unit selection.

5.11 File formats

NC-EAS(Y) loads Din 66025, Hpgl or Sieb & Maier  file types. This dialogue includes all the settings
which remain in connection with reading such files.

Hint: Changed settings do not change files loaded earlier on. Thus parameters must be set before a
file is opened.

DIN 66025
 In the event that a DIN 66025 file is loaded, the dialogue window "DIN 66025" displays speed rates
from the file. The speed rates for the DIN 66025 files are always  supplied in millimetres per minute.
The NC-EAS(Y) program makes use of the speed rate quoted in millimetres per second, so the speed
of the DIN 66025 files is automatically recalculated. If the speed rates are inappropriate, they may be
adjusted by providing a vector or by selecting a speed rate from a vector list in the toolbox.   

Description Key Menu command Icon
Adjusting the speed of the
opened file type DIN 66025

none Settings · DIN 66025 none

3
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DIN 66025 type files have the following settings available:
· command G02/03 (clockwise or counter-clockwise arc) always relatively
· vector with invert, change of axis Z direction
· letter definition for 4th axis
· selection of arc resolution, from low, medium to high
· definition of transmitters (command M) which may be used for turning on or off various devices

through files of Din 66025 type

Hint: Settings in the section "Various" are active in the course of opening a new file of the DIN 66025
type. Alteration of settings does not change the previously loaded file. This is why the parameters must
be set first and then the file should be opened.

Hpgl
Sometimes it may be required that the tool, once it immerses in the material, does not commence
work immediately but pauses for a particular period of time. This may be achieved with the application
of the "Time after tool lowering" function expressed in milliseconds.

Before the actual work commences, a delay may be defined needed for reaching adequate rotation
speed of the spindle with a tool. This function is called "Spindle acceleration time" and is inactive
when working on data in DIN 66025 standard. For Din 66025 the delay time is defined in the file.

Sieb & Maier
There are two different types of drill data (see: Interpreter of drill data ). Select one of the two types
by ticking the type chosen.

5.12 Save the settings

Upon finishing work with the program all the settings are automatically saved. If needed, the settings
may be saved in the course of running the program through the activation of the "Save settings"
function in the main menu "Settings". 

12
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6 Move

 The main menu "Move” includes functions which control the advance of the CNC milling machine. 

6.1 Simulation

 The simulation function allows for the acknowledgement of the path which the milling tool is to follow in
the course of performing actual work. The simulation speed may be changed in the main menu
between the options of slowly, average, fast and extremely fast. 
 

Description Key Menu command Icon
Simulation start-up none Move · Simulation · Start none

Choice of simulation speed none Move · Simulation · slowly /
average / fast / extremely fast

none



NC-EAS(Y) help32

Copyright © 1993 - 2006 by Michael Boenigk

6.2 Milling/Drilling

Clicking on the  icon in the horizontal toolbar or pressing the F9 key function starts up the progress
of the CNC milling machine. Before the actual start-up, the  "Work parameters" dialogue window
appears, where it is possible to set the final parameters. 

Description Key Menu command Icon
Processing [F9] Move · Milling/Drilling

Illustration 1: The "Work parameters" dialogue window.

Selection of data and their sequence of performance 
Data of the printed-circuit board consists of files with the HPGL type of vectors and files with drill points
of the Sieb & Maier type. The NC-EAS(Y) program may open both the files in one document, process
and display them. In this case it is necessary to select the processing data from the tab "Vectors" or
"Drill points" (see: illustration 2). In the event that the current document has only the drill points or only
the vectors, only one tab is displayed and there is no possibility of choice (see: Illustration 3). Quoting
values for "Repeat processing" and "Notch correction in millimetres" is possible by clicking the
adequate line and column in the table. Value 0 of "Repeat processing" parameter indicates that the
processing / milling shall be performed once only. Value 1 indicates that the process is repeated one
time, etc. This function, along with the notch correction in axis Z, facilitates such processing when the
material must be subjected to several working cycles e.g. the milling of deep holes in metal, grinding
etc.
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Illustration 2: Here both vectors and  drill points are present so it is necessary to select the data.

Illustration 3: Here only the vectors are present so there is no possibility of selection.

The vector and drill point lists display all the tools in use in the processing-sequence order. To allow for
the possibility of changing the order of the tools, at least two tools must be used. In the event that the 
"Change tool" option is not switched on, the first tool is always selected for the processing work.

Illustration 4: The "Tool change" function is switched on. The sequence of processing is changed by
selecting a tool and pressing the arrow keys.

Properties
The "Properties" tab includes the following functions: 
· The function "Measure the tools" may not be switched on without the function "Change tools". Once

a tool is changed, the spindle moves to the tool length sensor which shall measure the tool and on
this basis an adequate correction shall be performed. A standard micro-switch may be applied as
the sensor. Once the measurement is performed, the processing is continued.

   Hint: More information on the topic of „Measure the tools " is included in the chapter „Measure the
tool  "

· Flight altitude is the distance between the tool (milling cutter) tip from the material in the course of
idle advance (above the material).

· At the end of processing such actions may be defined: "Tool up", "Move to point zero", "Perform
reference move", "Tool down" (applicable only with active automatic tool changer), which are
performed once milling or drilling is completed.

· After a pause is performed, it is possible to perform such actions as: "Tool up" or "Move to park
point". For more information go to chapter 'Pause '.

· In a situation when the height scan has already been performed previously, the height correction

37

42



NC-EAS(Y) help34

Copyright © 1993 - 2006 by Michael Boenigk

option may be activated. For more information go to chapter "Material height scan ".

Macro
The Macro function is described in chapter "Macros ".

6.3 Manual advance

The "Manual advance"  dialogue window includes several functions which concern the manual
advance of the CNC milling machine. This dialogue window does not block the main menu of the
NC-EAS(Y) program and may remain open all the time.  

Description Key Menu command Icon
Manual advance of the
CNC milling machine

[Ctrl + W] Move · Manual advance

The "Manual advance" dialogue window includes the following functions:
· Manual advance with the keys 
· Manual advance speed 
· Move to and fro 
· Turn on or off the drill spindle and the pump 
· Material offset
· Reference move , park point , zero point , measurement/scan point

Manual advance with the keys
The CNC milling machine may be operated by pressing the arrow keys (Tabulator and Spacebar) or
with the use of the mouse. Each axis is monitored in the process of manual advance. The control over
each particular axis may be separately switched on or off. With the function "Relative advance" a move
is made of a precisely defined length. To perform the move, the length (segment) must be  indicated in
millimetres and an appropriate arrow key must be pressed. The arrow key indicates the direction of the
move. There are three boxes to enter the move segments, and it is possible to switch between them
without the necessity to enter the values again.

Manual advance speed
Here three different manual advance speed rates for axes X, Y, Z and A are defined, expressed in
millimetres per second. The selected speed rate is used in the "Key move" and "Move to and fro"
functions. Additionally, a very slow advance (5 steps per second) is available. This advance mode is
used for the function "Manual advance with keys" and facilitates precise positioning on axis Z.

Move to/Move to and fro
Functions "Move to" and "Move to and fro" include the possibility of controlling the machine. In both
functions the destination point is determined by entering relevant data with the use of the keypad.
When the "Start" key is pressed a particular operation is started up, and when the "Cancel" key is
pressed the operation is stopped. 
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Illustration: The "Move to" and "Move to and fro" functions make absolute advance of the CNC milling
machine possible.

The position may be entered into the X, Y boxes with the use of the mouse (left mouse key). To make
this possible the  "Insert positions x,y with mouse" box must be ticked. 

Drill spindle and pump
The power feed of the drill spindle motor and the pump may be turned on or off in the course of
manual advance. In this case the machine functions just like a standard milling machine with control
over the path length.

6.4 Height of drawing measurement

To transform HPGL files into 3D type files, the drawing must be divided into small vectors and then the
height of the vectors must be measured at their starting and final points. The resulting measurements
are saved along with the HPGL coordinates as file Din 66025.  

Description Key Menu command Icon

Divide the drawing into
small vectors

none Process · Drawing · Split
vectors

none

Measurement of height of
drawing

none Move · Height measurement
· Drawing measurement

none

Show  starting and final
points of vectors
graphically on the screen.

none View · Starting and final
points of vectors

none

6.5 Reference move, and moves to positions

In the "Move" main menu or in the menu of the "Manual advance" dialogue window it is possible to
perform reference moves or a move to the park point, the zero point or the measurement/scan point. 

Description Key Menu command Icon
Reference move [F12] Move · Reference move
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Move to park point [F10] Move · Park point none

Move to zero point [F11] Move · Zero point
Move to measurement
point

none Move · Measurement point none

For the CNC machine to recognise the position of the CNC machine axis, a reference move must be
made, for example each time the NC-EAS(Y) program is started up or after a move is interrupted. In
the "Reference move" dialogue window the axes, which are to perform the reference move, are
selected. A reference move may also be performed manually in the main menu "View". Once the
reference move is performed, the absolute coordinates are deleted (see: Status bars ).

In order to perform a move to the zero point, park point or the measurement point, the points must first
be defined in the "Position " dialogue window. 

6.6 Calibration of the tool-length sensor

To be able to use the tool-length sensor, its calibration must once be performed. Calibration of the
sensor is performed with the use of the calibration assistant.

Description Key Menu command Icon

Calibration of the tool-length sensor none Move · Tool · Measure the tool none

Delete the measurement values none Move · Tool · Delete the
measurement value

none

The assistant performs the following actions, in this order:

1. Reference move
For the position of the CNC milling machine to be adequate, a reference move must be performed. If
the reference move has already been performed before, this step may be skipped by clicking
"Continue".

2. Table height measurement
Please fix a chosen tool and move in axis z till the tool tip touches the  CNC milling machine table. The
saved height of the CNC milling machine results, together with the material thickness, in a new axis z
height at point zero. Please note that the material thickness starts at the table height and finishes at
the top edge of the material (see: Illustration). 

Illustartion: Height of the machine table and  thickness of material result in the height of point zero  

Hint: In the "Positions" dialogue window the new height of point zero may be defined by providing the
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material thickness data. 

3. Measurement of the height of the tool-length sensor 
Now a move is performed to the sensor in order to measure its height.

4. Summary
This last page of the assistant shows the height of the table and the height of the tool-length sensor at
its start. By clicking on the "Complete" option the values are saved and the assistant is closed. 

Hint: If the tool-length sensor is not to be used again, the calibration data should be deleted.

6.7 Measure the tool

In order to measure the length of the tool, calibration of the tool-length sensor must once be
performed.

Description Key Menu command Icon

Manual measurement of tool length none Move · Tool ·  Measure tool none

 If several parts are to be produced with the use of the same tool (serial production), it is wise to
perform the tool measurement just once. This way a multi-time performance of the tool measurement
before the milling of each part may be avoided. To avoid a multi-time performance of the tool
measurement, it is also necessary to turn off the change and measure the tool functions in the "Work
parameters" dialogue window. 

6.8 Material height scan

 In order to enable the engraving of an uneven material surface, the material height measurement
(scanning with an appropriate raster) may be performed first. With the aid of thus acquired data,
correction of the Z axis is performed in the course of engraving or milling; in this case the milling cutter
penetrates the material to an unchanging and constant depth (+/- tolerance). 

Description Key Menu command Icon
Material height
measurement/scan

[F11] Move · Material height scan

Illustration: The "Material height scan" dialogue window parameters. 
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The dialogue window parameters in detail: 

Distance from the edge
To avoid error measurement on the material edge, the area under measurement should not be in
contact with the edge of the material.

Scan area
Here the size of the area under measurement is defined (in millimetres) in X and Y directions.

Division
The number of measuring/test points, that is the so-called raster, is calculated by the program on the
basis of dividing the length and the width of the material by the value quoted in the material division
box. For example, with the length of material equal 100 mm and the stand-off ratio (division factor)
equal 5, we shall come up with 6 measuring points distributed every 20 mm. With considerably even
surfaces, to achieve a sufficient height correction precision, few raster points are required. For control
purposes the scan area may be displayed on the screen.

Lift the height meter
This height is the distance between the tip of the tool and the material in the course of an idle move. 

Display the scan area
Switch on or off the display of the height measurement area.

Height scan deviation
At the end of the measurement, NC-EAS(Y) calculates the ideal values of a particular measurement
for each raster (square). The deviation is the difference between the ideal value and the measurement
value. The highest deviations are displayed. If a deviation is higher than 0,1 mm then the raster may
have a bulge or a notch. In such an event it is advisable to perform a height scan once again but with a
smaller raster.

Hint: A height scan deviation may also be displayed in the menu "View -> Height scan deviation".

Export/Import of height scan data
The height measurement data may be recorded through the main menu "File -> Height scan data ->
Export" as a DXF file (lines or points), Din 66025 file, a text file or the SCAN file type of the NC-EAS(Y)
program. The SCAN type file may be retrieved again later. The height scan deviation of the retrieved
SCAN type file may be quoted back from the main menu "View ->Height scan deviation". 

6.9 Tool change

This function is applicable exclusively along with the automatic tool changer . The function facilitates
automatic setting aside or picking up of tools.

7 Data editing

 The NC-EAS(Y) program has numerous functions meant for use when editing a drawing. All such
functions can be found in the main menu "Edit" and most of them may be activated by clicking the
icons on the vertical toolbar. The "Undo" function makes it possible to undo the last 10 changes.
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7.1 Insert, copy, rotate, mirror reflection and expand

 The main menu "Edit -> Drawing" has functions for the purpose of editing a drawing. A given drawing
or its part may be positioned differently, changed or copied. All the functions have been constructed
similarly and are made up of the same or similar elements.

The range defines the area (material or machine area) which is subject to positioning. Example: A
drawing may be positioned in the centre of the material by choosing the "Material" scope.

The displayed groups help to select the data which is subject to editing. Example: In the event that
only the drill points are to be moved with the use of the "Insert" function, the "Drill points" group must
be selected. Depending on the type of data at your disposal, the particular groups are on or off. 

Description Key Menu command Icon
The drawing may be positioned in the
centre or with relation to the zero
point or the machine area 

none Edit · Drawing · Locate

The drawing may be rotated (in
degrees) clockwise or
counter-clockwise 

none Edit · Drawing · Rotate

Mirror reflection of the drawing may
be performed on axis X or Y 

none Edit · Drawing · Mirror
reflection 

The drawing may be copied a
multitude of times 

none Edit · Drawing · Copy

The drawing may be expanded by
quoting the margin on the material or
the machine area 

none Edit · Drawing · Expand

7.2 Selection window

The "Selection window" allows for editing particular drawing elements with the mouse (moving,
rotating, copying or deleting). The first operation to be performed is the selection of relevant data type,

that is the "Vectors",  "Poly-lines", "Drill points" or "All", by clicking the  icon on the horizontal toolbar.
The graphic range of the drawing shall now display the mouse cursor (a cross) and the appropriate
data may be selected now. By pressing the left mouse key, moving the mouse, and pressing the left
mouse key again a rectangle is pulled to enclose the drawing or its part.  Eventually, the drawing or a
part of the drawing is enclosed in the rectangle (see: Illustration).
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Description Key Menu command Icon
Selection window allows for the selection
(with the mouse) of a drawing or a part of
the drawing for editing 

none none

Illustration: The content of the selection window is rotated with the use of the mouse. 

Once the data has been selected with the use of the mouse, a particular operation may be conducted
by choosing a key function and, by pressing the left mouse key, clicking on the content of the selection
window. 

Description Key Menu command Icon
Delete [Del] Edit · Selection

window contents ·
Delete

none

Copy [Ctrl +C] plus left mouse
key 

Edit · Selection
window contents ·
Copy

none

Move [Ctrl +X] plus left mouse
key

Edit · Selection
window contents ·
Move

none

Rotate Selection window centre 

 and left mouse key 
none none

7.3 Change of tool number and the direction of milling

 The direction of milling and the change of the tool number is performed in the "Properties" dialogue
window. In order to be able to change the properties, the drawing data intended to be changed must
be selected with the use of the "Selection window ". The "Properties" dialogue window displays the
current tool number of the selected data. If the selected data has more than one tool, then the tool
number is not displayed. Now the new tool number may be entered or the direction of milling and the 
"Change" key performs the required changes. 

Description Key Menu command Icon
Change of tool number and
milling direction

none none
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7.4 Removing drill points, height scan data and tool diameter
correction

The "Edit -> Delete" menu allows for the removal of the drill points and the height scan data and the
tool correction. 

Description Key Menu command Icon
Remove tool
diameter correction

none Edit · Remove · Tool diameter
correction

none

Remove drill
points 

none Edit · Remove · Drill points none

Remove height
scan data

none Edit · Remove · Height scan
data 

none

7.5 Correction of the trailing cutter

 Prior to the performance of cutting, the position of the trailing cutter with respect to the axes is not
known. Thus the Y direction must be set accordingly (see: Illustration 1). 

Description Key Menu command Icon
Correction of the Trailing cutter none Edit · Trailing

cutter correction
none

Illustration 1: Starting point of the trailing cutter.

Immediately after the start, the cutter must be adjusted with the help of the axial section in the Y
direction (see: Illustration 2).  
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Illustration 2: Axial section in the Y direction. 

In the "Trailing cutter correction" dialogue window the diameter of the trailing cutter is corrected. Cutter
offset is the distance between the rotation axes of the cutter and the cutter blade (diameter of the
cutter). Angle start defines the angle deviations for subsequent paths. The angles, in the course of the
correction of the trailing cutter path, are calculated. The bigger the angle start parameter, the more
rounded the angles. The recommended value equals 8 degrees. The Scale parameter expands the
drawing. Once the correction of the trailing cutter is calculated, the drawing may no longer be
expanded as the cutter's diameter has changed as well. 

7.6 Pause

 The pause enables milling to be continued from any given location. The location may be set manually

or in the course of milling by clicking the icon on the horizontal toolbar. In the numerical space for
introducing data in the "Pause" dialogue window, the number of the vector must be entered as the
location of a pause. With the aid of the group, a choice is made between the grill points and the
vectors. The parts of the drawing which are to be milled are displayed in grey colour.

Description Key Menu command Icon
Locate position, in the
course of milling

none none

Locate position, move/shift none Edit · Pause none

7.7 Tool diameter correction

Correction of the tool diameter determines if a tool needs to be moved to the left or to the right of the
drawing vector. NC-EAS(Y) facilitates the tool correction to the left, right, inside or outside (see
illustrations 1 to 4). The smoothing factor should have the value, in most cases of small vectors, from
15 to 45. The smoothing factor changes the data generated by the tool correction. Original vectors
remain unchanged. The higher the factor of smoothing, the fewer the small vectors and the thicker in
outline the tool diameter correction. Tool correction may only be performed for Hpgl files.

Illustration 1: Tool correction to the left, the arrow indicates the vector direction
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Illustration 2: Tool correction to the right, the arrow indicates the vector direction

Illustration 3: Tool correction to the inside

Illustration 4: Tool correction to the outside

7.8 Path optimisation

Path optimisation sorts out the data, removes small vectors (smoothing factor) and shortens the
working time of the CNC milling machine. Tool correction may be performed for all or for only one tool.
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8 Problem solving

Problem Possible solution
There is no connection
with the drive electronics
of EAS USB Controller.

EAS USB Controller
· Disconnect the USB cable and plug in again.
· Change the USB cable to a different one. 
· Turn off the electronics and turn it on again. 
· End the program and restart. 
· Check in the Windows system tool manager if the

electronics drive is recognized by Windows. The
USB-Controller section must state: EAS USB
Controller

In the course of a
reference move at least
one axis moves slowly
from or to the axis
connector.

· The reference move directions have been set
wrongly and must be changed. For a correct setup of
the pin connectors please use the "Reference pin
assistant". More information in the "Machine
parameters " chapter.

The CNC milling machine
can be heard working but
does not operate.

· The stepper motors are not supplied with enough
electric current which, in case of stepper motors,
must be inverted. More information in the "Machine
parameters " chapter.

The CNC milling machine
works well at the
beginning. After a few
minutes either
communication is
interrupted or inexpicable
errors occur.

· Probably the computer switches off on its own after a
few minutes. Please turn off the Power Management
in BIOS. Please also check the power management
in the options of Windows management panel.
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